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Chapter 2 

Transformation Factors 
Conversion factors are used to change the numbers that represent measurements into different units of 

measurement. The thing being measured does not change—just the units used to measure it. Processes that 

combine or transform things have inputs and outputs. For example, when a cook at a restaurant orders food 

from a supplier, he or she uses a recipe that estimates the number of servings that can be made from bulk 

containers of flour, sauce, or pasta. The cook transforms the ingredients into servings. An experienced cook 

will allow for some spoilage, waste, or theft and order extra. The difference between the amount of goods 

purchased and the amount that goes into the final product is called shrinkage. The shrinkage is a direct loss to 

the restaurant and is a number that the manager will monitor closely. In this chapter, numbers that describe 

energy processes are explained but the same concepts apply to many different types of numbers from the 

shrinkage estimate at a restaurant to the manufacturing of automobiles.  

Why do I need to know this? 
The nation's economic future depends on decisions that will be made about energy in the coming years and 

quantitative reasoning must play an important role if those decisions are to be made wisely. These decisions 

are too important to use only half of our reasoning ability. Few people know enough about energy 

measurements or the effectiveness of different processes to make an informed decision and it will be up to 

people like you who understand these factors to make informed decisions and help focus the debate on 

solutions that can meet real measurable objectives. To compare sources and processes to make the best 

choices, it is necessary to compare the transformation factors that vary widely between types of energy and 

how they are transformed.  

1 Work, Energy, and Power 

Learning Objectives 
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1. Identify and apply the concept of work. [2.1.1] 

2. Identify energy and power measurements used with work. [2.1.2] 

The rate at which energy is transformed from one form into another is power. There are several different 

processes by which this can take place but one of them is particularly important. In physics and engineering, 

the word work has a very specific meaning. It is the method of transforming energy that involves exerting a 

force through a distance. For example, when a piston pushes a drive rod in a steam locomotive, it is doing 

work. Work is calculated as the product of distance and force (the force must be in the same direction as the 

distance). Work can have the same units of measure as energy. In the International system, work is measured 

in joules. In the American system, the unit of work is measure is foot∙pounds.  This concept is used most 

often in the transformations shown in figure 2.1. 

 

Figure 2.1. Examples of energy transformation. 

The rate at which the energy is transformed into useful work is another way to look at the concept of 

power. For tasks like those transformations listed above, we can define power as work divided by time (work 

/ time).  

Early in the history of steam engines, an enterprising inventor named James Watt was selling an 

improved model of a steam engine that was more efficient and faster than its predecessor. James recognized 

that a qualitative comparison would not be as convincing as a quantitative comparison and used a 

measurement unit that everyone could understand. He compared the power of his steam engine to the power 
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of horses. He used an estimate that a good horse could provide 550 foot∙pounds of work per second and 

popularized horsepower as a unit for measuring power. This unit made it very easy to make quantitative 

comparisons between his engines and those of his competitors. He took his payment as a fraction of the mine 

owner’s savings on coal, which was a very profitable way to sell his engine at no risk to the mine owner. 

Horsepower is a popular unit of measure because it is easy to understand and is still used today. It is the 

preferred measurement of automobile engines in the American system and is often used in the International 

system. The international system uses joules / second but they often use horsepower for automobile engines. 

For a more complete understanding of work, energy, and motion the student is encouraged to take a 

course in the physics of motion and the laws that describe it. 

Key Takeaways 
 Work is defined as the amount of energy that is transformed by exerting a force through a distance 

Work can be measured in foot∙pounds. Power is the rate of energy transformation into useful work; 

Power = Work / Time. [2.1.1] 

 In the American system, work can be measured in foot∙pounds and power can be measured in 

foot∙pounds/second. In the international system, work can be measured in joules and power 

measured in joules per second. A larger unit is the horsepower where 1 hp = 550 

foot∙pounds/second. [2.1.2] 

2 Electricity, Energy, and Power 

Learning Objectives 
1. Identify measurement units for charge, current, potential per unit of charge. [2.2.1] 

2. Identify electrical energy and power measurements. [2.2.2] 

3. Calculate a characteristic of electricity if you know two other characteristics. [2.2.3] 

4. Define capacity factor and identify typical capacity factors of power sources that use coal, nuclear, 

solar, and wind. [2.2.4] 

Electrical energy is one of the most versatile forms of energy. It is easily transported through wires and many 
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devices exist that can transform other forms of energy into electrical energy. Many people are considering 

ways to use electricity to power automobiles and heat homes. Knowledge of electricity is fundamental to 

understanding sustainable energy alternatives to fossil fuels. 

Fortunately, the American system uses the SI units of measure for electrical energy and power. The 

electrical measurements have a few oddities of their own, one of which is that famous scientists or inventors 

who discovered the properties of electricity were honored by using their names for the units of measure such 

as Coulomb, Ampere, Volt, Joule, and Watt as shown in the table in Figure 2.2. 

 

Figure 2.2. Conversion factors. 

A common practice that can be confusing is that the unit of electrical energy is commonly expressed 

in terms of the unit of power multiplied by time. Instead of stating the energy in joules, it is expressed in 

watt∙hours. A watt∙hour is the power in watts multiplied by the time in hours. To convert watt∙hours into 

joules: 

1 watt∙hour = 1 joule/sec ∙ 3,600 seconds / 1 hour = 3,600 joules 

A watt∙hour is not a large amount of energy. Electrical energy is commonly measured in 

kiloWatt∙hours which are 1,000 watt∙hours: 

1 kWh = 3,600,000 joules 

When you receive your electric bill, the units of measure for the energy you used are kiloWatt∙hours 
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which are usually abbreviated kWh, as shown in Figure 2.3. 

 

Figure 2.3. Electrical energy is measured in kiloWatthours. 

There are two simple formulas that show how the characteristics of electricity relate to each other. 

They are: 

Power = Energy / Time 

Power = Potential ∙ Current 

Each of the formulas can be reorganized according to the rules of algebra so that you can find one of 

the characteristics if you know two other characteristics.  

1) If you know that a circuit in your house has a potential of 120 volts (potential) and it can handle up 

to 20 amps (current), you can calculate that it could deliver up to 2,400 watts (Power = 120v ∙ 20amps = 

2,400 watts (power)).  

2) If you have an outdoor security lamp that has a power rating of 200 watts and it is on for 8 hours, it 

will use 1600 watt∙hours of energy (Energy = Power ∙Time = 200 watts ∙ 8 hours = 1,600 watt∙hours = 1.6 
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kiloWatt∙hours) 

Batteries 

Alternative energy sources that are not constant such as wind and solar need to store energy for use at times 

when it is not being generated. Automobiles that use electricity instead of liquid fuel must store the electrical 

energy in a portable form. A common solution to this storage problem is the use of batteries. Batteries 

contain pairs of chemicals that react with each other to produce an electric current. In rechargeable batteries, 

this chemical process can be reversed to store energy. 

The coulombs of charge that a battery can produce are measured in amp∙hours. The flow of current at 

one amp is one coulomb per second. If that current flows for an hour, it would transfer 3,600 coulombs 

because there are 3,600 seconds in an hour. 

1 amp∙hour = 3,600 coulombs 

The joules of energy provided by the battery are the product of the coulombs of charge and the 

potential of the battery in volts because a volt is joules/coulomb (joules = coulomb ∙ volts). 

For example, a typical 12 volt automobile battery might have a storage capacity rating of 120 

amp∙hours. The energy stored in the battery is: 

120 amp∙hours ∙ 3,600 coulombs/amp∙hour ∙ 12 joules/coulomb = 5,184,000 joules 

A rechargeable AA size nickel metal hydride battery has a capacity of 2,500 milliamp∙hours and a 

potential of 1.2 volts. A milliamp is 1/1000 amp so this is 2.5 amp∙hours. The energy stored in the battery is: 

2.5 amp∙hours ∙ 3,600 coulombs/amp∙hour ∙1.2 joules/coulomb = 10,800 joules.  

Capacity Factor 

Some types of energy are available more reliably than others. For example, a power plant that uses coal must 

shut down occasionally for cleaning and repairs. The ratio of the energy that a source produces in a year to 

the energy it could produce if it ran continuously is its capacity factor. The capacity factor of a coal power 
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plant is usually between 80% and 90%. 

For example, the coal-fired power plant at Monroe Michigan shown in Figure 2.4 has a power rating 

of 3,014,000 kiloWatts.  

 

Figure 2.4. Coal-fired power plant at Monroe Michigan being renovated with pollution 

controls. 

If it could run at that capacity continuously 24 hours a day for 365 days, it would produce 

26,402,640,000 kilowatt-hours of energy in a year. It normally produces about 22,000,000,000 kilowatt-

hours a year. If we divide the actual by the maximum possible we get 0.83 or 83% which is the capacity 

factor.  

 
                  

                
  
   

             
  
                  

                  
     

 

 A nuclear plant needs less cleaning and they only shut down every year or so to replace about a 

fourth of the fuel rods so the capacity factor of a nuclear plant can exceed 90% if they do not have any 

unexpected mechanical failures. For example, the Fermi II nuclear plant in Monroe Michigan has a rated 

capacity of 1,100,000 kilowatts and produces about 9,100,000,000 kilowatt∙hours per year. The capacity 

factor is: 
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Solar powered systems on earth do not produce power at night and clouds reduce output during the 

day. Solar systems usually have capacity factors between 15% (Michigan) and 24% (California). For 

example, an installation in Ann Arbor Michigan of 120 solar panels that are 6 feet by 4 feet has a rating of 

28.4 kiloWatts and produces 38,000 kiloWatt∙hours in a year. The capacity factor is: 

 
          

           
  
   

             
  

          

           
     

 

One of the natural resources of the U.S. is a large arid region with few cloudy days. A solar panel 

installation of 72,000 PV panels at Nellis Air Force Base, shown in Figure 2.5, has a much better capacity 

factor. (Large-scale photovoltaic power plants, 2008) 

 

 
              

             
  
   

             
  

              

               
     

 

 

Figure 2.5. Solar panels in the desert at an air force base. 

 

Wind turbines transform the energy of motion of air into electric energy. They produce energy when 

the wind is blowing. The power that can be extracted from the wind is very sensitive to the wind speed. In 

http://www.nellis.af.mil/news/story_media.asp?id=123079933
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areas where the wind does not blow consistently at speeds above 15 miles per hour the capacity factors for 

wind turbines are usually below 30%. For example, there are two wind turbines in Michigan near Mackinaw 

City, as shown in Figure 2.6 that are rated at 900 kiloWatts each. Each produces about 2,000,000 

kiloWatt∙hours per year. The capacity factor is: 

             

          
  
   

             
  
             

             
     

 

 

Figure 2.6. Wind turbines in Michigan. 

California is a leader in wind power and gets 1.5% of its electrical energy from wind energy. They 

put wind turbines on hills that have no trees, as shown in Figure 2.7. 
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Figure 2.7. Wind turbines in California. 

 In 2004, California had 1,990 turbines rated at 1,697,000 kilowatts that produced 4,258,000,000 

kilowatt-hours of energy. This is a capacity factor of: 

 
                 

                
  
   

             
  

                 

                  
     

 

If two sources of energy have different capacity factors the annual amount of energy should also be 

compared. For example, if someone advocated replacing the nuclear power plant in Monroe Michigan with 

wind turbines like the ones in Mackinaw City, they might compare their maximum power output and 

conclude that it would take 1,222 wind turbines (1,100,000 kW / 900 kW). Because they have very different 

capacity factors, the actual amount of energy should be considered. To produce the same amount of energy it 

would take 2,124 wind turbines.  

                  

             
         

In general, to compare two sources of energy using their power ratings they should have similar 

capacity factors. If the capacity factors are not similar, compare the total energy produced in a year’s time. 

Key Takeaways 
 Charge is measured in coulombs, current is measured in amps, potential per coulomb is measured in 

volts. [2.2.1] 

 Electric energy is measured in joules or kiloWatt∙hours. 1 kWh = 3,600,000 joules. Electric power 

is measured in watts or kilowatts. [2.2.2] 

 The characteristics of electricity are expressed by two formulas; Power = potential ∙ current and 

Power = energy / time  [2.2.3] 

 The capacity factor is the ratio of the energy actually produced to the energy that could be produced 

in the same time at maximum power. The capacity factor for Nuclear is over 90%, coal is in the 
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80% range, wind below 30%, and solar around 15-25%. [2.2.4] 

3 Transformation Efficiency and Coefficient of 
Performance 

Learning Objectives 
1. Define transformation efficiency. [2.3.1] 

2. Identify typical transformation efficiencies. [2.3.2] 

3. Describe how to calculate the efficiency of a process that consists of more than one transformation. 

[2.3.3] 

4. Define coefficient of performance (COP) and give an example. [2.3.4] 

Energy can be changed from one form into another or concentrated within the same form. In this section, the 

efficiency of transforming energy is described and compared to the process of concentrating energy in the 

same form. 

Transformation Efficiency 

The process of transforming energy from one form into another is never 100% successful. In many types of 

processes, less than half of the energy ends up in the intended form. The rest of it turns into forms like heat, 

sound, and light that disperse into the surroundings. The ratio of the amount of energy that is transformed 

into the intended form to the amount of energy that went into the process is the transformation efficiency. 

For example, when an electric motor transforms electric energy into the energy of motion, about 75% 

of the electric energy is transformed into motion and 25% of the energy turns into heat in the motor. In this 

example, the efficiency of the electric motor is 75%.  

The transformation efficiency can be applied to power as well as energy because it is the energy 

component that is being transformed—the amount of time remains the same. It is important to determine if 

the power rating of a device is the input power or the output power. The relationship between input power 

and output power is: 
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Output power = input power ∙ transformation efficiency 

For example, the transformation efficiency of a small electric motor is about 75%. Most motors are 

rated by their power output. If a small electric motor is rated as a 1200 watt motor, the input power will be 

1,600 watts: 

Input Power = Output power / transformation efficiency = 1,200 / .75 = 1,600 watts 

Other types of devices are commonly rated by their input power. For example a 100 watt light bulb 

has an input of 100 watts but it only transforms about 2.6% of that power into visible light. The large 

majority of its energy is wasted as heat and infrared (invisible) light. Fluorescent lights are about four times 

more efficient at transforming electric power into visible light so a 25 watt fluorescent lamp can put out as 

much visible light as a 100 watt incandescent bulb (or four times as much light for the same input power). 

When the stored chemical energy in gasoline is transformed into the energy of motion of a car, it is 

only about 20% efficient. The other 80% of the fuel’s energy is turned into heat of the exhaust gasses and 

noise. The table in Figure 2.8 shows several transformation processes and their efficiencies. 
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Figure 2.8. Transformation efficiencies. 

If a process consists of a sequence of transformations, the efficiency of the whole process is a product 

of the individual transformations. For example if electricity is generated by a wind turbine (30%), stored in a 

lead-acid battery car battery (80%), and then sent to a small electric motor (75%) the overall efficiency of the 

process is 18%. (Process efficiency = 0.30 ∙ 0.80 ∙ 0.75 = 0.18 = 18%) 

Moving Heat Energy 

The amount of heat energy in air, water, or solids is related to their temperature. If objects of two different 

temperatures are brought in contact with each other, the heat in the higher temperature object flows toward 

the lower temperature object until they are about the same temperature. To reverse this process takes work. 

For example, if the electric power goes off in your home, the heat in the house will flow into the refrigerator 

and warm up its contents. When the power is restored, a device in the refrigerator reverses this process and 

moves heat energy out of the interior of the refrigerator lowering the internal temperature. The heat is moved 

into the warm house against the natural direction of flow. The ratio of the amount of heat forced to move 

against its natural tendency compared to the energy it took to move it is the device’s coefficient of 

performance (COP). Similarly, the ratio of the rate of energy flow in joules/sec to the power rating of the 

device is the same ratio if the measurement units of time and energy are the same. A device that moves heat 

without transforming it is called a heat pump. An air conditioner is another example of a heat pump. It moves 

heat from inside the home to the outside where the temperature is higher. The coefficient of performance 

(COP) of a home air conditioner is about 3.0 which means that it moves three units of heat out of the house 

for every one unit of electrical energy put into the unit.  

Heat pumps can be used to heat homes. They move heat from the cold outside air into the house. Heat 

pumps are used in southern parts of the U.S. where the air temperature does not get extremely cold. In 

northern areas of the U.S., heat pumps move heat from water that is pumped from below ground where the 

temperature does not go below about 55
o
 F. Electricity from environmentally friendly sources can be used 
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with heat pumps to heat homes instead of burning fossil fuels like natural gas or fuel oil. 

For more information about the behavior of electric energy and heat pumps, the student is encouraged 

to take a course in the physics of electricity and thermodynamics. 

Key Takeaways 
 Transformation efficiency is the ratio of the energy output in the desired form divided by the energy input. [2.3.1] 

 All transformation efficiencies are less than 1. Examples are; Internal combustion engine 20%, power plant 40%, 

wind turbine 20%, solar panel 16% [2.3.2] 

 If a process has more than one transformation, multiply the efficiencies together to find the process efficiency. 

[2.3.3] 

 The coefficient of performance is the ratio of heat moved to energy used to move it. The COP of an air 

conditioner is about 3:1. [2.3.4] 

4 Calculating Transformations, Formatting, and 
Documenting Sources 

Learning Objectives 
1. Find and apply energy and power transformation efficiencies. [2.4.1] 

2. Use the following spreadsheet skills: write formulas, widen columns, apply number styles, select 

cells, and change decimal places. [2.4.2] 

3. Insert comments to identify sources and assumptions [2.4.3] 

4. Use formatting to identify the answer to the problem using fill color. [2.4.4] 

5. Prepare a spreadsheet for printing by adding custom headers, changing page orientation, and using 

print preview. [2.4.5] 

One of the most common transformations of energy is burning fuel to move something. In the early days of 

steam engines, coal was burned to raise coal from deep mines. In modern times, we burn gasoline to move 

cars and trucks. In both cases, the energy is transformed into useful form by doing work. 
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Lifting coal from a mine 

In this exercise, the amount of coal that an early steam engine could raise from a mine by burning coal is 

calculated to demonstrate how energy is transformed. 

1. Start Excel. Navigate to the location of files for this class, and then open Ch02Transformation.xlsx and 

then save the file as Ch02TransformationStudentName using your own name in place of StudentName. 

2. Click the Steam sheet tab. 

3. Read the problem which is stated in cells A2 and B2. Because this problem involves work, which is force 

multiplied by distance, the common unit of energy measure will be the foot∙pound. Observe the first step 

is to convert the energy of one ton of coal into foot∙pounds. 

4. Switch to a Web browser and go to onlineconversion.com. Find the conversion from a ton of coal to foot 

pounds. Select the conversion factor, as shown in Figure 2.9.  

 

Figure 2.9. Large conversion factor selected including spaces. 

5. Press and hold the CTRL key and then press C to copy the selected number. Switch to the Steam 
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worksheet. Click cell E3. Press and hold the CTRL key and then press V to paste the selected number 

into the cell, as shown in Figure 2.10. Observe that the number is too long to fit in the cell. 

 
Figure 2.10. Large number with spaces pasted into E3. 

6. Before you press the Enter key, click the number in the Formula Bar. Edit the number to remove the three 

spaces, and then press Enter. The number is represented using scientific notation, 2.16E+10.  

Tip: Scientific notation is a method of working with very large numbers. In this example E+10 
represents a multiplier with ten zeros, 10,000,000,000. 

7. Click cell E3. On the Home tab, in the Number group, click the Comma Style button . This will force 

the program to display the entire number. 

8. The number is too long to be displayed in the cell. Instead, the program displays a row of pound signs to 

indicate that the number is too long to display in the cell, as shown in Figure 2.11. 

 
 

Figure 2.11. Number too long to display. 

9. Move the mouse pointer to the boundary line between column headings E and F, as shown in Figure 2.12. 
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Figure 2.12. Pointer shaped is a two-headed arrow on the boundary between column 

headings. 

10. Double-click the column border to automatically widen the column to fit the longest number or text in the 

column. 

11. On the Home tab, in the Number group, click the Decrease Decimal button  two times to remove the 

decimal places.  

12. Double-click the boundary line between the column headings for columns E and F again to reduce the 

column width. 

13. With cell E3 selected, on the Review tab, click New Comment. In the comment box, under your name 

type From onlineconversion.com.  

14. In cell F3, type =C3*E3 and then press Tab to move to cell G3. The result is the answer to the first 

question: What is the energy of a ton of coal in foot∙pounds 

15. In cell G3, type foot pounds and then press Enter. 

16. The result of the first conversion will be used as the given value in row four. Click cell C4. Type =F3 and 

then press Tab. This is a simple method of transferring the result of one calculation for use in the next. 

17. In D4 type foot pounds and then press the Tab key.  

Tip: Entering content into a cell is a two-part process. First you type and then you move off of the 
cell using the Enter key, an arrow key, or the Tab key. To complete the process without moving from 

the cell, click the Enter button, , on the Formula Bar. 

18. In E4, type 5% and then press the Tab key.  

19. Add the following comment to cell E4; Assumes steam engine that exhausts the steam. 
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20. In F4, type =c4*e4 On the Formula bar, click the Enter button so that cell F4 remains the active cell. 

This formula calculates the amount of work done per ton of coal by multiplying the energy in a ton of 

coal by the transformation efficiency factor.  

Tip: When typing a cell address you can use lower or upper-case letters. Excel is not case-sensitive. 
In this book, the instructions will display formulas using upper-case letters for clarity and 
consistency, but you can type the cell references using lower-case letters. 

21. Right-click and on the Mini toolbar click the Decrease Decimal button  two times to remove the 

decimal places. 

22. In cell G4, type foot pounds and press Enter.  

Tip: Notice that as you type, Excel displays foot pounds. This is the AutoComplete feature which 
supplies possible selections based on other data that has been typed in the same column. To use the 
displayed value, make sure the suggestion is selected and then press Enter to accept it in the cell. 

23. In cell C7, type =F4 and press the Tab key. In cell D7, type foot pounds and press the Enter key. 

24. In cell C8, type 500 and press the Tab key. In cell D8, type feet and press the Enter key. 

25. Read cell B6 where the algebra of reorganizing the basic formula of Work = Force x Distance is 

explained. In cell C9, type = click cell C7, type / and then click cell C8. Compare your screen with Figure 

2.13.  

Tip: You can create formulas by using this point-and-click method. You begin by typing an equal sign, 
then click the first cell in your formula, type the appropriate mathematical operator, and then click 
the next cell in the formula before pressing or clicking Enter. This can be useful in understanding the 
process, or making sure that you are selecting the correct cell. 
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Figure 2.13. Cell references are color-coded to match the cell that is outlined. 

26. On the Formula Bar, click the Enter button. The result is force in pounds, which is the weight of the coal 

that can be lifted. 

27. Using the Mini toolbar, or the Home tab, click the Decrease Decimal button  two times to remove the 

decimal places. 

28. In cell D9, type pounds and press the Enter key. 

29. In cell C11, type =C9 and press the Tab key. Type pounds and press the Tab key. 

30. Switch to onlineconversion.com and find the conversion factor for converting pounds to short tons. Copy 

or type the number into cell E11.  

31. In cell F11, type =C11*E11. On the Formula bar, click the Enter button. Click the Decrease Decimal 

button two times to remove the decimal places.  

32. Press the Tab key. In cell G11, type tons and press the Enter key. Compare your worksheet with Figure 

2.14. 

 
 

Figure 2.14. Calculations completed. 

33. Check your work. In cell C3, change the number from 1 to 2. If you followed the directions correctly, 
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your final answer should become 2,162 tons. Change the number in cell C3 back to 1. 

34. Save the workbook. Keep it open for use in the next part. 

Formatting to Indicate Answers and Authorship 

The results of a calculation can be lost among the other numbers on a worksheet. To make the final result and 

the independent variables on which it depends stand out, colors and cell outlines can be used. To print a 

worksheet on the fewest pages and to label its pages to identify ownership and sequence, headings can be 

used. To ensure that a worksheet prints on one page, preview it prior to printing. 

1. On the Steam tab, click and drag cells F11 through G11. On the Home tab, in the Font group, click 

the Fill Color arrow. A list of fill colors displays. 

2. In the ninth column, move the cursor to the fourth color. A screen tip displays Aqua Accent 5, Lighter 

40% as shown in Figure 2.15. Click to apply the fill color. This is the answer to the question that was 

originally asked. 
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Figure 2.15. Fill colors display ScreenTips for color selections. 

3. Select cells A13:B15. On the Home tab, in the Alignment group, click the Merge & Center button 

arrow  and select Merge Cells from the list of options. Then click the Wrap Text button . In 

the merged cell write a sentence that answers the question that is stated in cell B2. Be sure to include 

in your answer all of the limitations and assumptions that are stated in the question. 

4. On the Page Layout tab, in the Page Setup group, click Print Titles to display the Page Setup dialog 

box. 

5. In the Page Setup dialog box, click the Header/Footer tab. Options for creating custom headers and 

footers display, as shown in Figure 2.16. 

 

Figure 2.16. Options for creating custom headers and footers. 

6. In the Page Setup dialog box, on the Header/Footer tab, click the Custom Header button. 

7. With the cursor in the Left section, type Edited by: Student Name (Use your name in place of Student 

Name.) 

8. Press the Tab key. With the cursor in the center section, type the name of your class. 

9. Press the Tab key. With the cursor in the right section, click the Insert Date button . A code will 
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display that will be replaced by today’s date. Compare your Header dialog box with the one in Figure 

2.16. 

 

Figure 2.17. Custom header created for the selected worksheet. 

10. In the Header dialog box, click the OK button. In the Page Setup dialog box, click the Print Preview 

button. The worksheet displays as it would print. Notice that at the bottom of the window it displays 

Page 1 of 2. 

11. On the Print Preview tab, in the Preview group, click the Next Page button. The second page is 

displayed which is the last three columns of the worksheet. This does not produce a satisfying result 

because the information is not all on one page. 

12. On the Print Preview tab, in the Print group, click the Page Setup button to return to this dialog box. 

13. In the Page Setup dialog box, click the Page tab. Under Orientation click the Landscape button, and 

then click OK. Now the worksheet displays on one page. If you need a printed copy, click the Print 

button on the Print Preview tab. Otherwise, click the Close Print Preview button. Dotted lines display 

on the worksheet which outlines the print area of each page. 

Tip: On the Page Layout tab, in the Page Setup group is an Orientation button that can be used to 
quickly change a worksheet between portrait and landscape orientation. If you need just a bit more 
width or height in a worksheet, Excel also has a Fit to Page option. This will proportionally shrink the 
data to fit on one page. You can also change the Margin settings from the default of 1" on all sides 
to a smaller setting to help display information on one page. 

14. At the bottom of the window, click the Page Layout button, . Use the Zoom bar, 
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, if necessary to display the entire page. If you see a cell with ### signs, 

widen the column to display the cell contents. Adjust column widths if necessary to keep the work on 

one page, as shown in Figure 2.18. 

 

Figure 2.18. Page layout view with header. 

15. Confirm that your information is in the header. At the bottom of the screen, click the Normal button 

. Save the workbook. 

Driving up Haleakala 

One of the few places in the world where you can drive a car from sea level to the top of a volcano is in 

Hawaii on the island of Maui. The drive from Kahului on the sea coast to the top of Haleakala volcano is 38 

miles. During that drive, the car will climb 10,023 feet vertically. The vertical portion of this trip is similar to 

raising coal from a deep mine. In this case, the car's engine must lift the car and its passengers 10,023 feet. A 
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resident of Kahului is considering buying an all-electric Nissan Leaf. The range of the car on flat ground is 

about 100 miles between charges using its batteries that hold 24 kWh of energy. The normal range of the car 

is sufficient for the person's normal commuting needs but he would like to be able to take visitors to the top 

of the volcano. The question is how many additional kWh of the battery's energy would be needed to lift the 

car and four passengers to the top of the volcano compared to a similar trip on level ground? 

In the following exercise, you solve the problem using methods that are similar to the steam engine 

problem but with less step-by-step instruction so that you gain confidence in your ability to solve such 

problems on your own. 

1. Click the Car worksheet tab. The problem is stated in cells A2 and B2. Because this problem involves 

work, which is force multiplied by distance, the common unit of energy measure will be the foot∙pound. 

In row 3, begin by converting one kilowatt∙hour of battery energy into foot∙pounds. 

2. In row 4, multiply the result from row three by the appropriate transformation efficiency found in table 

2.8 in the Transformation section of this book.  

3. In section b, the objective in this instance is to find the amount of work it would take to lift the car and its 

passengers from sea level to the top of the volcano. In cell C8, enter the elevation of the volcano. 

4. The force needed to lift the car to the top is the car's weight plus the weight of the passengers. Use a 

search program on the Internet and look up the weight of a Nissan Leaf. Copy the Web address of the site 

where you find the information. Try to find an authoritative site instead of an individual's blog. 

5. In cell C9, enter the weight of the car plus the weight of its passengers.  

6. Add a comment to C9. Explain your estimate and include the hyperlink to the website. 

7. In C7, enter a formula that multiplies the distance and the force (weight) to find the work needed to lift 

the car and its passengers to the top. The answer will be between thirty and fifty million foot∙pounds. 

8. In cell C11, divide the work that must be done in C7 by the energy in a kWh after it is transformed by the 

electric motor from F4. 



   

 

Copyright ©2011 – John Preston  Page 25 
 

9. In C11, reduce the decimal places to two. Your answer will be less than 24 kWh extra depending on your 

assumptions. 

10. In cell C12, answer the question: Will the car be able to make it to the top? Add a comment to explain 

your answer. 

Wind Turbine Alternative 

An example of how quantitative reasoning affects a discussion is demonstrated by considering a choice 

between putting up wind turbines and building a conventional power plant. Qualitative arguments often miss 

aspects of an issue that quantitative arguments can reveal. For example, a regional power cooperative is 

considering building a new power plant that has a rating of 800 megawatts. Some members of the 

cooperative want to consider using wind power, while others favor existing systems that use natural gas, coal, 

or nuclear energy. There are many factors to consider but a quantitative question that is seldom asked is; 

"How many wind turbines would it take?" 

In the following exercise, you solve the problem using concepts from the text with a few tips. 

1. Click the Wind worksheet tab. The problem is stated in cells A2 and B2. Notice the comparison is 

between the amount of energy produced in a year, rather than a comparison of power ratings. 

2. In row 3, convert the power rating from megawatts to kilowatts. 

3. Transfer the result from cell F3 to the next row in cell C4. In cell F4, convert the power rating to energy 

by multiplying by the hours in a year. Use the conversion factor from years to hours. 

4. Transfer the results to cell C5. In cell F5, multiply by the capacity factor for a nuclear power plant given 

as an example in the text. The result is the target the wind turbines should match. 

5. In row 6, assume that a large wind turbine is used that has a power rating of 1 megawatt. Convert it to 

kilowatts.  

6. In row 7, multiply by the hours in a year to convert the power rating into energy production for the year. 

7. In row 8, multiply by the capacity factor for a wind turbine. Use the capacity factor given as an example 
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for the Mackinaw wind turbines in the text.  

8. In row 9, divide the annual energy from the nuclear plant in row 5 by the annual energy from one wind 

turbine to determine how many would be needed.  

9. Format the numbers in columns C and F using comma style with no decimal places. The answer will be 

close to three thousand.  

Tip: The group realized that buying land and transmission line right-of-way had not been considered 
for three thousand wind turbines. A member of the cooperative did some additional research and 
found an article regarding wind farms in Ontario that pointed out that even though their nine wind 
farms had an average capacity factor of about 25%, the monthly capacity factor was much lower in 
July (15%) when they needed the most power for summer air conditioning.  

 

10. In cell E8, use 15% for the capacity factor to determine the number of wind turbines the co-op might 

need during July if the co-op's wind farms expected similar seasonal variation. 

11. Save the workbook and submit it as directed by your instructor. 

Key Takeaways 
 Transformation efficiencies are always less than one. They can be found at sites like onlineconversion.com or by 

searching the Internet. Frequently they are much less than one such as 40% for transformation from fuel into 

electricity. Electric motors have efficiencies of about 75% and cars about 20%. [2.4.1] 

 Widen columns by double clicking the border between column headings or by dragging the column border. 

Apply number styles and set decimal displays using the buttons in the Number group, from the Mini toolbar or 

the Format Cells dialog box. Be consistent in the application of styles and number of decimals within a column. 

[2.4.2] 

 On the Review tab, choose New Comment or right-click on a cell and then choose Insert comment from the 

shortcut menu. Use comments to document sources, assumptions, limitations or other information.[2.4.3] 

 Identify answers using background fill or borders from the Font group on the Home tab. [2.4.4] 

 Custom headers, footers, and page orientation can be chosen from the Page Setup dialog box, which is displayed 

from the Page Setup group in the Page Layout tab; alternatively, use the buttons on the Page Layout tab, in the 

Page Setup group. Use Print Preview before a printing to review the worksheet to ensure that it will print on one 
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page and all of the data and numbers are clearly labeled and displayed. [2.4.4] 
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Key Terms 

Ampere (Amps) 

Measure of the flow of electric charge (current) equal to 1 coulomb per second. Named for André-Marie 

Ampère. 

Amphour 

Measure of the charge stored in a battery. The energy of that charge is found by multiplying the capacity in 

amphours by the potential in volts. 

Capacity factor 

Ratio of actual energy production to the product of the rated power and the hours of operation. 

Coefficient of Performance (COP) 

Ratio of energy moved to the energy needed to move it. Also the ratio of the rate of energy movement to the 

power needed to move it. 

Coulomb 

Measure of charge. Specfically the sum of the individual charges on a 6.24 · 10
18

 of electrons or protons. 

Heat pump 

Device that concentrates heat and moves it from a lower temperature environment to a higher termperature 

environment. 

Joule 

SI unit of energy. Named after James Prescott Joule. 

Output power 

Usable power from a device. 

Shrinkage 

Amount of ingredients that do not make it into the finished product due to spoilage, loss, or theft. 

Transformation efficiency 

Ratio of the amount of energy or power  

Volt 

The potential energy of one joule per coulomb of charged particles. Named for Alessandro Volta. 

Watt 

Unit of power used with electricity. Equal to 1 Joule per 1 second. Named after James Watt. 
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Watt∙hour 

Unit of energy used to measure electrical energy. Power in watts multiplied by the time in hours.  

Work 

Force multiplied by distance in the direction of the force. 
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